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1 Getting Started 
 

 This lesson will review the steps necessary for getting started with the 
TRANSPROC ISM.   In this lesson we will review the following subject 
matters: 

 
 Requesting a ISM Login and Password 

o Obtaining and Completing the FH Form 25-29-R-E (for 
Installation Functional Administrator accounts) 

o Requesting a General ISM user account – not IFA 
 
 Logging into the TRANSPROC ISM 
 
 Pre Configuring Discoverer Settings 

 
 Logging into Discoverer for the first time 

o Windows Users 
o Windows XP Users 

 
 TRANSPROC ISM Main Menu 

o TRANSPROC Application Links 
o TRANSPROC Main Menu Options 

 
 Navigation Features of TRANSPROC 

o Breadcrumbs 
o Tabs 
o Smart Search Buttons 
o Calendar Button 
o Mandatory Fields 

 
 Submitting Problem Reports and Engineering Change 

Proposals (ECPs) 
 

Target Audience:  All TRANSPROC Users 
 
 

Estimated Training Time:  30 minutes 
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1.1 Process for Requesting a Installation Functional Administrator (IFA) 
ISM Login and Password 

 
The TRANSPROC Installation Functional Administrator (IFA) accounts are 
managed by the CONUS-TNOSC.   To request an IFA account you must submit 
a completed FH Form 25-29-R-E to your installation IASO (Information 
Assurance Security Officer).  Once your IASO signs off on the form to approve 
authorization for the account, the IASO will then submit an account request 
trouble ticket to CONUS-TNOSC via the CONUS-TNOSC Remedy system [See 
Security Features User Guide (SFUG)] for detailed information.   Once the IASO 
submits the trouble ticket to CONUS-TNOSC they will verify the request 
information and establish your IFA account.  Once the account is established you 
will receive an e-mail notification stating that your account has been approved.  
Your AKO username and password will also serve as your TRANSPROC ISM 
user name and password.   
 
If the CONUS-TNOSC gives you access to the Discoverer ad hoc reporting tool, 
you will receive a second e-mail which provides a temporary password to 
Discoverer.  Receipt of this e-mail may be delayed since the system generates 
Discoverer temporary passwords only every 30 minutes. 
 
1.1.1 Obtaining the FH-Form 25-29-R-E 
 
From your computer desktop: 
 
1. Launch an internet explorer session by clicking on the Internet Explorer 

icon.  
 
2. In the Address field at the top of the page, enter the following URL:  

https://ism.army.mil.  The following dialog box will appear: 
 

 
 

3. Enter your AKO username in the User Name field and click on the 
password field. 

 

https://ism.army.mil/
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4. Enter your AKO password in the Password field and click on the OK 
button.  If your AKO username and password are valid, the following page 
is displayed: 

 
 
5. Click on the Request Account button or the Request Account link on 

this page.  The following page will appear: 
 

 
 
Click on any FH Form 25-29-R-E link on this screen. The following screen will 
appear: 
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6. Click on the print icon or select File > Print from the menu bar to print out 

the FH Form 25-29-R-E.   
 
7. Complete the FH Form 25-29-R-E manually and submit the form to your 

IASO.  The IASO will sign the form to approve authorization for your ISM 
IFA account.   

 
1.1.2 Completing the FH Form 25-29-R-E 
 
Instructions for completing the FH Form 25-29-R-E are shown below.  
 
Part I: Action Requested  
 

a. Select New Account 
b. Leave this field Blank 
c. Select DAISM 
d. Enter TRANSPROC ISM 
e. Enter your job description, such as TRANSPROC functional administrator for Fort 

Belvoir. 

 
Part II: Requestor Information 
 
Enter in your personnel information  
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Part III: Security Access Verification (Must be completed by the 
Organizational Security Officer) 
 

a. Select the Security Access Level associated with the individual requesting an account, if 
the person does not have a security clearance then you can add None (X) to the end of 
the field 

b. Complete the Security Manager information as necessary. 
 

Part IV: Responsibilities Requirements (Must be completed by the 
Requesting Organization and System Proponent) 
 
Complete the signature blocks as necessary. 

 
Once you have this information completed, provide a copy to your IASO for 
submission to the CONUS-TNOSC.  The CONUS-TNOSC will verify the request 
information and establish your IFA account.  Once the account is established you 
will receive an e-mail notification stating that your account has been approved.  
Your AKO username and password will also serve as your TRANSPROC ISM 
user name and password.   
 

If the CONUS-TNOSC gives you access to the Discoverer ad hoc reporting tool, 
you will receive a second e-mail which provides a temporary password to 
Discoverer.  Receipt of this e-mail may be delayed since the system generates 
Discoverer temporary passwords only every 30 minutes 
 

1.2 Process for Requesting an General ISM Login and Password  
 
The process for requesting a general ISM login/password and a IFA ISM login 
and password is very similar.   
 
All general TRANSPROC ISM user accounts are managed by the Installation 
Functional Administrators (IFAs) and the alternate IFAs (AIFAs). Each IFA or 
AIFA sets up general user accounts for all general TRANSPROC ISM users at 
the installation.  General TRANSPROC users include all users EXCEPT the 
Subject Area Functional Proponent (SAFP), the Physical Disability Branch User, 
and the Installation Functional Administrator.  The IFA can grant access to 
alternate IFAs.  Alternate FAs can perform the same functions as the IFA.  Each 
installation can have up to 4 alternate IFA accounts.   
 
The first step for submitting a general ISM user account request is to manually 
complete the FH Form 25-29-R-E.  Once completed, this form must be submitted 
to the IFA to ensure that you have the proper clearance/authorization to access 
the TRANSPROC ISM.  After submitting the form to the IFA, you must then 
submit your request online.  Sections 1.2.1 and 1.2.2 will provide you with the 
step by step procedures for requesting a general ISM account. 
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1.2.1 Printing and Completing the FH Form 25-29-R-E 
 
From your Computer Desktop: 
 
1. Launch an internet explorer session by clicking on the Internet Explorer 

icon.  
 
2. In the Address field at the top of the page, enter the following URL:  

https://ism.army.mil.  The following dialog box will appear: 
 

 
 

3. Enter your AKO username in the User Name field and click on the 
password field. 

 
4. Enter your AKO password in the Password field and click on the OK 

button.  If your AKO username and password are valid, the following page 
is displayed: 

 

 
 

5. Click on the Request Account button or the Request Account link on this 
page.  The following page will appear: 

 

https://ism.army.mil/
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6. Click on any FH Form 25-29-R-E link on this screen. The following screen 

will appear: 
 

 
 
7. Click on the print icon or select File > Print from the menu bar to print out 

the FH Form 25-29-R-E.   
 
8. Complete the FH Form 25-29-R-E manually and submit the form to your 

IASO.  The IASO must sign the form to approve authorization for your 
account.  The form must then be submitted to the TRANSPROC IFA.   
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FH Form 25-29-R-E completion instructions 
Block To be completed by Info to be entered 

Part Ia. Type of Action User Requesting Account New Account ( X ) 

Part Ib. TSACS…. N/A N/A 

Part Ic. Access Req….. User Requesting Account DAISM ( X ) 

Part Id.  For DAISM,… User Requesting Account TRANSPROC ISM 

Part Ie. Other or 
Special… 

User Requesting Account Write in your user role, ie. RSO, 
Installation Sep User, Alternate IFA 
& the installation you wish to access 

Part IIa-h.  User Requesting Account Self Explanatory 

Part IIIa. Security Access 
Verification 

Organizational Security Officer Select the Security Access Level 
obtained with the individual 
requesting the account.  If no 
security access level exists add 
None ( X ) to the end of the field to 
indicate they do not currently have a 
security access level  

Part IIIb. Security 
Manager 

Organizational Security Officer Self Explanatory 

Part IVa. User Requesting Account Self Explanatory 

Part IVb. Supervisor of Individual 
Requesting Account 

Self Explanatory 

Part IVc. Installation Information 
Assurance Service Officer 

Self Explanatory 

Part IVd. Contracting Officer 
Representative 

Self Explanatory- this section is 
necessary if the individual requesting 
the account is a contractor 

 
Note:  In order to request or gain access to the TRANSPROC ISM you must 
have a valid AKO User ID. 
 
1.2.2 Initiating the online request for a General ISM user account: 
 
Once you have completed the FH Form 25-29-R-E you can proceed with the 
following steps to initiate their account request. 
 
From your computer desktop: 
 
1. Launch an internet explorer session by clicking on the Internet Explorer 

icon.  
 
2. In the Address field at the top of the page, enter the following URL:  

https://ism.army.mil.  The following dialog box will appear: 
 

 

https://ism.army.mil/
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3. Enter your AKO username in the User Name field and click on the 
password field. 

 
4. Enter your AKO password in the Password field and click on OK.  If your 

AKO username and password are valid, the following page is displayed: 
 

 
 
5. Click on Request Account or on the Request Account link on this page.  

The following page will appear: 
 

 
 

6. In the User Information region at the bottom of the Request ISM User 
Account page, enter the following online account request information: 

 
a. In the Organization field, enter the unit with which you are affiliated 

(Mandatory data entry field). 

b. In the Building/Rm Number field, enter the building and room 
number in which you reside (Mandatory data entry field).  
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c. In the Duty Phone Number field, enter the duty phone number 
including area code (Mandatory data entry field-Dashes not 
necessary).  

d. In the Email field, enter your e-mail address.  (Mandatory data 
entry field. Your correct e-mail information is needed since your 
user account information will be e-mailed to you.) 

e. In the Confirm Email field, enter your e-mail address again.   Scroll 
to the bottom of the page and click on Save. The Request Account 
Access page is displayed (Mandatory data entry field) as follows: 

 

 

 

7. Select TRANSPROC from the Module: drop-down list and click on 
Continue.  The Account Access Details page will appear as follows: 

 

8. Select your installation from the Installation(s): drop-down list.   

9. Input your job description into the Job Description: data entry field. 

 

Module drop 

down option 



TRANSPROC VER 2.6.1.2 FA Reference Manual Getting Started  
 

 
July  2007 11 U.S Department of Army 
 

10. Click the Request Access button.  The access request is displayed in the 
Requested Roles region at the bottom of the page. 

 

 

 

11. Repeat Steps 7-11 if you want to request access to multiple application 
modules or installations.   

 

Note:  Step 8 directs you to select TRANSPROC and step 9 directs you to select 
your installation, but you can select any module or installation from the drop 
down list (This allows you to request access to multiple modules or installations 
in a single operation.) 

 

12. Prior to continuing the request process, review the access that you have 
requested.  If you: 

 

 Need to change information shown in the User Information region, click the 
Back button at the bottom of the page. 

 Need to delete an access request, click the check box next to the request 
that you want to delete then click the Delete Selected button.  A message is 
displayed prompting you to confirm that you want to delete the request.  Click 
OK in the message window.  The request is deleted from Requested Roles 
list. 

 Want to submit the access request, click the Submit button.  Your request(s) 
are submitted, and the ISM Log In page is displayed. 

 Want to cancel your request all together, click on the Cancel button at the 
bottom of the page, and the ISM Log In page is displayed. 
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13. To close (exit) the browser application, click on the X in the upper-right 
corner of the window. 

 

The access authorization form (FH Form 25-29-R-E) must be completed, signed, and 
submitted to the FA.  An account request cannot be processed until the FA 
receives this form. 

Upon completion of user information online, the FA can review the account 
request in the ISM application.  Once the FH Form 25-29-R-E is completed and 
submitted to your TRANSPROC IFA,  your ISM user account can be created.  If 
your TRANSPROC IFA has not received your account request then it may be 
possible that your request was submitted to the wrong installation. 

Once your ISM user account is approved by your IFA, you will receive an e-mail 
notification that confirms that the user account requested has been activated and 
is ready for use.  Your AKO username and password will also serve as your ISM 
username and password. 
 
If you were given access to Discoverer, you will receive your Discoverer 
password in an email notification ½ an hour to an hour after you receive your ISM 
account confirmation.   
 
1.3 Preconfiguring Discoverer Setting Prior to First Time Login 
 
Prior to logging onto Discoverer for the first time you may need to configure your 
internet settings in order to access Discoverer. 
 

From your Computer Desktop: 
 
1. Launch an internet explorer session by clicking on the Internet Explorer 

icon. 
 
2. Select Tools > Internet Options from the menu bar.  The Internet Options 

window is displayed. 

 
 

3. Click the Connections tab. 
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4. On the tab, click the LAN Settings button.  The Local Area Network (LAN) 

Settings window is displayed. 
 

 
 
5. In the window, if the Use a proxy server for your LAN check box is 

checked, click on it so that the check box is blank. 
 
6. Click OK on the LAN Settings window. 
 
7. Click OK on the Connections tab. 
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1.4 Logging Into the TRANSPROC ISM  
 
Once you receive your confirmation email, you can then logon to the 
TRANSPROC ISM application.   
 
From your Computer Desktop: 
 
1. Launch an internet explorer session by clicking on the Internet Explorer 

icon.  
 
2. In the Address field at the top of the page, enter the following URL:  

https://ism.army.mil.  The following dialog box will appear: 
 

 
 

3. Enter your AKO username in the User Name field and click on the 
password field. 

 
4. Enter your AKO password in the Password field and click on the OK 

button.  If your username and password are invalid, the prompt requesting 
your AKO username and password will continue to appear until you enter 
a valid AKO username and password.  If your AKO username and 
password are valid, the following page is displayed: 

 

 
 
5. Click on the Continue button.  The following screen will appear: 
 

https://ism.army.mil/
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6. Click on the OK button.  The Welcome to ISM screen will appear as 
follows: 

 

 
 

7. Click on the TRANSPROC link in the navigation bar to enter into the 
TRANSPROC ISM. 

 

Clicking on this 
link will take you 

into the 
TRANSPROC 

ISM 
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1.5 Logging on to Discoverer for the First Time  

If you have Windows XP as the operating system on your computer, refer to 
instructions for Logging on to Discoverer for the first time (Windows XP Users). 

When you log on to the Discoverer ad hoc query tool for the first time, you will 
have to: 

 Reset your password, 

 Install the Oracle JInitiator file, 

 Save the Oracle certificate file from an e-mail attachment, and 

 Log on to Discoverer again. 
 

 

You must have administrator privileges on your computer to download and install 
the Oracle JInitiator file.  (If you are able to install programs on your computer without 
getting any messages that you do not have authorization to do so, then you probably 
have administrator privileges, and can proceed with the file download and installation.) 

If you do not have administrator privileges on your computer, you must contact your local 
System or Network Administrator who can install the JInitiator file on your computer. 

 

From your Computer Desktop: 
 
1. Launch an internet explorer session by clicking on the Internet Explorer 

icon.  
 
2. In the Address field at the top of the page, enter the following URL:  

https://ism.army.mil.  The following dialog box will appear: 
 

 
 

3. Enter your AKO username in the User Name field and click on the 
password field. 

 
4. Enter your AKO password in the Password field and click on the OK 

button.  If your AKO username and password are valid, the following page 
is displayed: 

 

https://vatrain1.ism.army.mil/ism/help/guest/disco_logon_xp.htm
https://ism.army.mil/
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5. Click on the Continue button.  The following screen will appear: 
 

 
 

6. Click on the OK button.  The Welcome to ISM screen will appear as 
follows: 

 

 
 

7. Click the Discoverer link in the navigation bar.  A second browser window 
launches, displaying the Discoverer log on page. 
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8. In the Discoverer log on page, enter the temporary password that was e-

mailed to you in the Password field.   
 

 

The password is ―masked‖– asterisks (*) appear in the field instead of your 
password.  This ensures that your password cannot be viewed on the screen. 

 
9. Click the Connect button.  The Change Database Password page is 

displayed as shown below: 
 

 

Changing (or resetting) your password the first time that you log on to the 
Discoverer tool ensures security of the system.  An unauthorized person may find 
your temporary password and attempt to use it to log on to the system.  However, 
once you change the password, the temporary password becomes invalid and the 
attempt to breach the system is prevented. 
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10. Enter the temporary password that was e-mailed to you in the Current 
Password field.  Passwords are case-sensitive. 

 
11. Enter a new password in the New Password field.  
 

 

A Discoverer password must be at least eight (8) characters long and must contain 
at least two (2) numbers.  Passwords are case-sensitive so you may use a 
combination of uppercase and lowercase letters in the password.   

 
12. In the Verify New Password field, enter the password that you typed in 

the New Password field and click on the Apply button. (Entering the 
password twice ensures that you typed the password that you intended.) 

 
13. The following security warning message is displayed prompting you to 

install the Oracle JInitiator file. 
 

 
 
14. Click Yes in the security warning message.  The Oracle JInitiator setup 

wizard launches, displaying the Choose Destination window 
 
15. Click Next in the Choose Destination window.  The setup wizard executes, 

and the file is installed on your computer.  Depending upon your computer 
settings, an Installation Complete message may be displayed. 

 
16. Click OK in the Installation Complete message window.  The Oracle9iAS 

Discoverer Plus window opens and Discoverer starts to execute.  An error 
message may be displayed. 
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The error message indicates that Oracle cannot run using the HTTPS protocol, 
which is the protocol used by the ISM system.  To get Oracle Discoverer to run 
properly, you will edit an Oracle certificate file. 
 
17. Click on OK in the error message until it no longer appears.  (You may 

have to click  on OK several times.)  A Java error window is displayed. 
 
18. Close the Java error window by clicking the Close icon . 
 
19. Exit Discoverer by selecting File: Close in the browser window.  (This will 

close all Discoverer windows.)  
 
20. Log out of TRANSPROC and close Internet Explorer. 
 
21. Now you need to save the Oracle Certificate File from the E-mail 

Attachment. 
 

A modified Oracle certificate file (certdb.txt) was sent to you as an 
attachment to the e-mail that contained your temporary Discoverer 
password.   
 

22. Launch your e-mail application, and locate the e-mail that supplied your 
temporary Discoverer password.  This e-mail has a couple of attachments, 
but the attachment file named "certdb.txt" is the file that will modify the 
Oracle certificate file. 

 
23. Save the "certdb.txt" attachment file in the following directory:  
 
C:\Program Files\Oracle\JInitiator 1.3.1.21\lib\security (In some cases the 
Local Disk is D:\, if this is the case with your workstation then you need to 
save the file to D:\Program Files\Oracle\Jinitiator 1.3.1.21\lib\security).   
 
You will be prompted to confirm that you want to overwrite the existing file; click  
on Yes.  The attachment is saved in the directory, and the Oracle certificate file is 
modified. 
 
If you have Microsoft Outlook or Microsoft Outlook Express, you can save the attachment by 
performing the following: 

1. Select File: Save Attachments.  The Save Attachment window is displayed. 
2. Navigate to the directory where you want to save the attachment (see the directory path in Step 

17), and click the Save button.  A message is displayed asking whether you want to overwrite the 
existing file. 

3. Click Yes in the message window.  The attachment is saved in the directory, and the Oracle 
certificate file is modified. 
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-OR- 

1. Right click on the ―certdb.txt‖ and select the option to ―Save Target As‖, then select your 
destination C:\Program Files\Oracle\JInitiator 1.3.1.21\lib\security.  In some cases the Local 
Disk is D:\, if this is the case with your workstation then you need to save the file to D:\Program 
Files\Oracle\Jinitiator 1.3.1.21 

 
24. Exit your e-mail application. 
 
25. Login to the TRANSPROC ISM via the ISM login screen.  This will bring 

you to the ISM Main Menu. 
 

26. Click the Discoverer link in the Welcome to ISM page.  A second 
browser window launches, displaying the Discoverer log on page. 

 
27. In the Discoverer log on page, enter your Discoverer password in the 

Password field.   
 
Remember, you changed your password when you first logged on to Discoverer.  You need to use 
this password, not the temporary password. The password is “masked”– asterisks (*) appear in the 
field instead of your password.  This ensures that your password cannot be viewed on the screen. 
  

28. Click the Connect button.  The Oracle9iAS Discoverer window is 

displayed (with the Workbook Wizard window on top) as shown: 
 

 If you need instructions for the Discoverer tool, see Discoverer Manual  
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1.6 Logging on to Discoverer for the First Time (Windows XP users) 

When you log on to the Discoverer ad hoc query tool for the first time, you will 
have to: 

 Reset your password, 

 Install the Oracle JInitiator file, 

 Save the Oracle certificate file from an e-mail attachment, and 

 Log on to Discoverer again. 
 

You must have administrator privileges on your computer to download and install the Oracle 
JInitiator file.  (If you are able to install programs on your computer without getting any messages 
that you do not have authorization to do so, then you probably have administrator privileges, and can 
proceed with the file download and installation.) 

If you do not have administrator privileges on your computer, you must contact your local System or 
Network Administrator who can install the JInitiator file on your computer. 
 

From your Computer Desktop: 
 
1. Launch an internet explorer session by clicking on the Internet Explorer icon.  
 
2. In the Address field at the top of the page, enter the following URL:  

https://ism.army.mil.  The following dialog box will appear: 
 

 
 

3. Enter your AKO username in the User Name field and click on the password 
field. 

 
4. Enter your AKO password in the Password field and click on the OK button. 

The following page is displayed: 
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If your AKO username and password are not valid the dialog box in step 2 will appear until 
you enter a valid AKO username and password. 

 
 

5. Click on Continue.  The Welcome to ISM page will appear as follows: 
 

 
 

6. Click on the DISCOVERER link from the Welcome to ISM page.  A second 
browser window launches, displaying the Discoverer log on page. 
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7. In the Discoverer log on page, enter the temporary password that was e-
mailed to you in the Password field.   

 

 

The password is ―masked‖– asterisks (*) appear in the field instead of your 
password.  This ensures that your password cannot be viewed on the screen. 

 

8. Click the Connect button.  The Change Database Password page is 

displayed as shown below: 
 

 

Changing (or resetting) your password the first time that you log on to the 
Discoverer tool ensures security of the system.  An unauthorized person may find 
your temporary password and attempt to use it to log on to the system.  However, 
once you change the password, the temporary password becomes invalid and the 
attempt to breach the system is prevented. 

 

 
 
9. Write down or note the Discoverer User Name and Database information that 

is displayed on the Change Database Password page.  

 

Your Discoverer user name is usually your last name followed by your first initial; 
however, there may be cases in which the Discoverer user name is different. 

 
10. Enter the temporary password that was e-mailed to you in the Current 

Password field.  Passwords are case-sensitive. 
 
11. Enter a new password in the New Password field.  
 

 

A Discoverer password must be at least eight (8) characters long and must contain 
at least two (2) numbers.  Passwords are case-sensitive so you may use a 
combination of uppercase and lowercase letters in the password.  Discoverer 
passwords cannot begin with special characters. 
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12. In the Verify New Password field, enter the password that you typed in the 

New Password field.  (Entering the password twice ensures that you typed 
the password that you intended.) 

 
13. Click on Apply.  The following screen is displayed: 
 

 
 
14. At the top of the blank page that displays, click on the bar that says "This site 

might require the following ActiveX control..."  A pop-up menu is displayed, as 
shown above. 

 
15. Select the Install ActiveX Control option from the pop-up menu.  The 

Discoverer Database Log On page is displayed as shown below: 
 

 
 

In the Discoverer Database Log On page, enter the following information: 
 
a. Your Discoverer user name in the User Name field (the one you 

wrote down in Step 10), 
b. Your password (the one you just changed—not the temporary 

password) in the Password field, and 
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c. The database name in the Database field (the one you wrote down 
in Step 10). 

d. Leave the End User Layer field blank. 
e. Leave the Language as the default English (United States). 
f. Click the Connect button.  The Install Active X page is displayed 

(as in Step 13). 
 
16. Click on the bar that says "This site might require the following ActiveX 

control..." and select the Install ActiveX Control option from the pop-up 
menu.  The following page is displayed. 

 

 
 

17. Click the Retry button in the message.  The following security warning 
message is displayed prompting you to install the Oracle JInitiator file. 
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18. Click Install in the security warning message.  The Oracle JInitiator setup 
wizard launches, displaying the Choose Destination Location window on top 
of the wizard window. 

 
19. Click Next in the Choose Destination window.  The setup wizard executes, 

and the file is installed on your computer.  Depending upon your computer 
settings, an Installation Complete message may be displayed. 

 
20. Click OK in the Installation Complete message window.  The Oracle9iAS 

Discoverer Plus window opens and Discoverer starts to execute.  The 
following error message may be displayed: 

 

 
 
The error indicates that Oracle cannot run using the HTTPS protocol, which is 
the protocol used by the ISM system.  To get Oracle Discoverer to run properly, 
you will edit an Oracle certificate file. 
 
21. Click OK in the error message until it no longer appears.  (You may have to 

click OK several times.)  A Java error window is displayed as shown below: 
 

 
 
22. Close the Java error window by clicking the  . 
 
23. Exit Discoverer by selecting File: Close in the browser window.  (This will 

close all Discoverer windows.)  
 
24. Log out of TRANSPROC and close Internet Explorer. 
 
25. Now you need to save the Oracle Certificate File from the E-mail Attachment. 
 

 A modified Oracle certificate file (certdb.txt) was sent to you as an 
attachment to the e-mail that contained your temporary Discoverer 
password.   
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26. Launch your e-mail application, and locate the e-mail that supplied your 
temporary Discoverer password.  This e-mail has a couple of attachments, 
but the attachment file named "certdb.txt" is the file that will modify the 
Oracle certificate file. 

 
27. Save the "certdb.txt" attachment file in the following directory:  C:\Program 

Files\Oracle\JInitiator 1.3.1.21\lib\security (In some cases the Local Disk 
is D:\, if this is the case with your workstation then you need to save the 
file to D:\Program Files\Oracle\Jinitiator 1.3.1.21\lib\security).  You will be 
prompted to confirm that you want to overwrite the existing file; click Yes. 
 The attachment is saved in the directory, and the Oracle certificate file is 
modified. 

 

 If you have Microsoft Outlook or Microsoft Outlook Express, you can save the attachment 
by performing the following: 

1. Select File: Save Attachments.  The Save Attachment window is displayed. 
2. Navigate to the directory where you want to save the attachment (see the directory 

path in Step 17), and click the Save button.  A message is displayed asking whether 
you want to overwrite the existing file. 

3. Click Yes in the message window.  The attachment is saved in the directory, and the 
Oracle certificate file is modified. 

-OR- 

2. Right click on the ―certdb.txt‖ and select the option to ―Save Target As‖, then 
select your destination C:\Program Files\Oracle\JInitiator 1.3.1.21\lib\security.  
In some cases the Local Disk is D:\, if this is the case with your workstation then 
you need to save the file to D:\Program Files\Oracle\Jinitiator 1.3.1.18 

 
29. Exit your e-mail application. 
 
30. Launch an internet explorer session by clicking on the Internet Explorer 

icon.  
 
31. In the Address field at the top of the page, enter the following URL:  

https://ism.army.mil.   
 
32. Enter your AKO username in the User Name field and click on the 

password field. 
 
33. Enter your AKO password in the Password field and click on the OK 

button.   
 

34. Click on the Continue button.   

 
35. The Welcome to ISM screen will appear. 

https://ism.army.mil/
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36. Click on the DISCOVERER link from the Welcome to ISM menu.  A 
second browser window launches, displaying the Discoverer log on page. 

 
37. In the Discoverer log on page, enter your Discoverer password in the 

Password field.   
 

Remember, you changed your password when you first logged on to Discoverer.  You 
need to use this password, not the temporary password. The password is “masked”– 
asterisks (*) appear in the field instead of your password.  This ensures that your 
password cannot be viewed on the screen. 

  

38. Click the Connect button.  The Oracle9iAS Discoverer window is 

displayed (with the Workbook Wizard window on top).  The first time 
loading can takes several minutes, you will see a magnifying glass and 
then a blank white screen, a blue bar appears in the lower right corner 
indicating that the program is loading. Eventually you will see the following 
screen: 

 

 
 
 
 
 
 



TRANSPROC VER 2.6.1.2 FA Reference Manual Getting Started  
 

 
July  2007 30 U.S Department of Army 
 

1.7 TRANSPROC ISM Main Menu 
 
The navigational features described below will assist you when navigating within 
the TRANSPROC ISM.  
 
1.7.1 TRANSPROC Application Links 
 
The following links are located in the top-right corner of the screen.  They are 
displayed on each application screen and are accessible by all users. 
 

 
 

 ISM Menu:  Clicking this link displays the Welcome to ISM screen , which shows general 
ISM announcements and the links to modules to which you have access. 

 Help:  Clicking this link displays the TRANSPROC online help system.  When you click 
on this link from any screen, context-sensitive help is displayed. 

 Log Out:  Clicking this link logs you out of (lets you exit) the TRANSPROC application, 
but does not close the browser window.  After you log out of TRANSPROC, the browser 
window may close. 

 
1.7.2 TRANSPROC Main Menu Options 
 

 
 

1.7.2.1 TRANSPROC User Roles 

 
 The TRANSPROC Installation Functional Administrator (IFA) has 

access to all end user and FA Admin sections associated with the 
TRANSPROC ISM.  The FA Admin section allows the IFA to perform 
functions related to the maintenance of installation-specific TRANSPROC 
data, such as adding and updating system announcements; updating or 
deleting Alternate Functional Administrators and/or Installation 
TRANSPROC Users; customizing TRANSPROC installation-specific 

These are the 
TRANSPROC Main Menu 
options.  These menu 
options are displayed on 
every window of the 
application, but it only 
displays items to which a 
user has access (as defined 
by the user’s role).  Clicking 
on the menu options, called 
menu links, displays the 
main screen of the 
functional area that you 
selected. This menu will 
display all the Major 
functions you have 
available. 

TRANSPROC 
Application 

Links 
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default data; creating/updating transition/retirement records; creating 
separation orders. 

1.7.2.2  TRANSPROC Main Menu Options 

 

 

1.7.2.2.1 Separation Processing Menu 

Clicking on the Separation Processing link will evoke the following screen: 
 

 
 

 Transition, this menu allows you to facilitate a soldier's transition from 
the active Army to civilian life or to another stage of Army affiliation. 

 

 Retirement, this menu allows you to facilitate a soldier's retirement 
from the Army. 

 

 Physical Disability Installation User, this menu allows you to review 
an individual’s physical disability information report, to view the 
installation’s physical disability branch notification/recall report and to 
acknowledge physical disability branch recalls. 

 

 Documents, this menu allows you to print documents created in 
TRANSPROC for a soldier or in a batch.  In addition this option allows 
you to print certificates for a soldier (the actual certificate form is not 
printed).   

 

 Reserve/National Guard Active Duty, this menu allows you to create 
and print an active duty report for a soldier as necessary. 

 

TRANSPROC Main 
Menu Options 
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1.7.2.2.2 Orders Menu 

 
Clicking on the Orders link will evoke the following screen: 
 

 
 

 Manage Orders, this option allows you to create separation/retirement 
orders and manage existing separation/retirement orders for a specific 
soldier. 

 

 Soldier Information, this option allows you to update a soldier’s 
personnel information in TRANSPROC. 

 

 Query Orders, this option allows you to search and retrieve existing 
orders created in TRANSPROC ISM. 

 

 Soldier Addresses, this option allows you to update a soldier’s 
address data from the Orders menu. 

 

 Orders Log, this option allows you to generate a report showing all the 
orders created for a specific date. 

 

 Reprint Final Orders, this option allows you to print a soldier’s 
finalized separation order(s) created in TRANSPROC.  
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1.7.2.2.3 Reports Menu 

 
Clicking on the Reports link will evoke the following screen: 
 

 
 

The Reports menu includes the following options: 
 

 ETS/ESA Loss Report, this option allows you to queue the ETS/ESA 
Loss Report, which allows you to select units and military classes 
(enlisted, warrant, or officer) to see all individuals separated within a 
specific date period.   

 

 SBP Election Report, this option allows you to queue the SBP 
(Survivor Benefits Plan) Election report.  This report allows you see the 
SBP elections for specific separation date period.  

 

 Finance Confirmation Report, the option allows you to queue the 
Finance Confirmation Report.   

 

 Pre-Separation/Pre-Retirement Briefing Report, this option allows 
you to queue the pre-separation/pre-retirement briefing eligibility or no-
show report. 

 

 Transition Statistics Report, this option allows you to queue the 
transition statistics report. 

 

 Transition Totals, this option allows you to queue the transition totals 
report. 

 

 Early Retirement Eligibility Report, this option allows you to queue 
the early retirement eligibility report. 

 

 Browse Reports, this option allows you to see all running, queued, 
and completed reports. 
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1.7.2.2.4 FA Admin Menu 

 
Clicking on the FA Admin link will evoke the following screen: 
 

 
 
The FA Admin menu includes the following links: 
 

 Manage Announcements, which lets you add, update, and delete a 
system announcement viewable by users at your installation. 

 

 Transition/Retirement Administration, which lets you manage local 
default settings for transition and retirement functions, generate logs 
such as the DD Form 214 Print Log and SPD Entry/Change Log, un-
tag a soldier's record, and reprint soldier forms that have been 
archived.  

 

 View Account Requests, which lets you view user account requests 
and approve accounts, and lets you assign account privileges. 

 

 Manage Existing Account, which lets you search for and manage 
existing user accounts. 

 
 
1.7.3 Navigational Features and Common Buttons of TRANSPROC 
 
There are some features of the TRANSPROC application that are common 
throughout the application.  These common features are described in the 
sections to follow. 
 

1.7.3.1  Breadcrumbs 

Breadcrumbs show the path you have taken in the application up to the current 
application page that is displayed.  They are located at the top of every 
application page. Each breadcrumb section is a link that lets you move back to 
any of the application pages listed in the breadcrumb.  See example below: 
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These breadcrumbs show that you are in the Transition > DD Form 214 path 
since they are the first sections of the breadcrumb.  The currently displayed page 
is called "DD Form 214 Specific Information" because it is the last section of 
the breadcrumb and is not underlined.  To return to the Transition or DD Form 
214 page, you would click the Transition or DD Form 214 link in the breadcrumb. 

1.7.3.2 Tabs 

A single page may contain multiple sub-pages called tabs.  Tabs allow a lot of 
related information to be accessed via a single application page.  You access a 
tab by clicking on it. 

 

In the TRANSPROC application, you must click the Save button to save the 
information you entered on a tab before moving on to another tab otherwise you 
could lose changes you have made to the page. 

1.7.3.3 Smart Search Button 

The Smart Search allows you to select a field value from a list instead of having 
to enter a value.  The Smart Search button is displayed next to fields that 
allow a Smart Search.  When you click on the icon, one of the following occurs: 

 A pop-up dialog displays a list of values list.  To select a value from the 
list, click on the value's link. 

 

 A message is displayed that you need to enter the first several 
characters of the value in the field before you can conduct the search. 
(This allows the Smart Search to shorten the list of values.) 

 

1.7.3.4 Calendar Button 

The Calendar pop-up dialog lets you select a date from the dialog instead of 
entering the date in the field.  (All dates are entered in the format YYYYMMDD.) 

These are breadcrumbs.  
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To use the calendar pop-up dialog, click the Calendar icon .  The calendar 
pop-up dialog is displayed.  Use the arrows to select a month and/or year, then 
click on the day link in the month.  The date that you select is displayed in the 
field in YYYYMMDD format. 

1.7.3.5 Mandatory Fields 

A mandatory field requires an entry—if you do not enter a value in a mandatory 
field, the system will prompt you to do so.  Each mandatory field has an asterisk 
(*) next to it to indicate that you must enter or select a value. 

1.7.4 Submitting a Problem Report or ECP from the ISM Login Screen 
 
Within the ISM Login page you have the option of logging into the CONUS-
TNOSC Remedy system in order to submit a problem report or an ECP.  You can 
access the CONUS-TNOSC Remedy web page login screen by clicking on the 
Submit ECP/Problem Report link.  You will then need a user login and password 
to the CONUS-TNOSC Remedy System or ARWEB.  If you do not have a user 
login and password to this system then you may submit your request via the 
CONUS-TNOSC helpdesk by clicking on the please email our Help Desk link 
 

 
 
                                           ISM Login Page 

Allows submission of ECPs 
via the CONUS-TNOSC 

Remedy Web Page.  

CONUS TNOSC 

Help Desk 800 # 


